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Chapter 1 - Introduction to the
program

Introduction to the program
The DIADIM program has been developed to design flexible retaining structures not only from the geotechnical
point of view but taking into account the structural and engineering problems as well.
The problem of dimensioning and verifying these structures is normally done through methods of calculation
based on the principle of the global limit equilibrium, that contain necessarily simplifications in the description of
the terrain’s behaviour, the definition of the structure’s restraint conditions and the distribution and magnitude of
the pressures.
To these limitations should be added the incapacity of these methods to give indications on the deformations.
The scheme used by the program to represent the terrain’s behaviour (ideal elastic-plastic terrain represented
by a series of springs uphill and downhill constituted with diverse rules) permits the verification of complex
situations within very short time.
Given the terrain’s stratigraphy and the position of the water table uphill and downhill of the structure during the
various phases of excavation the program calculates the bulkhead as an elastic beam held by elastic-plastic
supports (their elastic constant is defined by the modulus of the sub-surface or by plastic limits calculated on the
base of the terrain’s characteristics).
This gives the user the possibility to select the different restraint conditions at the top and the bottom. It is
possible to define more anchoring points and applied loads (thrust from the terrain, water, tension bars and
stresses on the extremities).
The bulkhead can be calculated in a single phase or in successive phases that most certainly have their
influence on the stresses and hence on the final deformation of the structural element.
After having calculated the stress conditions of the beam the program verifies wether the section examined can
absorb the stresses it is subjected to.
The verification of the section is subdivided in two parts:

→ Verification of the moment and normal stress: it is performed in the section under the highest stress with the
Ultimate Limit State method, Eurocode 2, that takes into account the mechanical non-linearity of materials
and the non-linearity of the structure. The program determines the bending moment and the normal stress of
the calculation and confronts these respectively with the ultimate bending moment before failure and
ultimate normal resistive stress.

→ Shear Verification: this is performed with the standard method described under Eurocode 2. The program
determines the maximum shear force acting on the section and that this is smaller than the bearing capacity
of reinforced concrete beams (Vrd2) and of the reinforcements (Vrd3).
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Chapter 2 - System requirements
and program installation

System requirements
• Pentium® class processor

• Microsoft® Windows® 95 OSR 2.0, Windows 98, Windows Me, Windows NT®* 4.0 with Service Pack 5 or
6, Windows 2000, or Windows XP

• 64 MB of RAM (128 MB recommended)

• 100 MB of available hard-disk space

• CD-ROM drive

• A printer driver must be installed, even if the printer itself is not connected to the PC.

Program Installation
To install DIADIM run the diadim32setup.exe installation package from the CD-ROM or from the download
directory.

Press the Setup button…
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…and select the directory to create the DIADIM32 folder.
Click the Continue button and the program program is automatically installed.

The first time you run the program the window that allows you to select your preferred language appears. Simply
click on the flag of the language you prefer.

The language selection will be saved in the “LANGUAGE.CFG” file, which is found in the program directory. To
select another language, it is sufficient to exit the program and delete this file. The language selection window is
shown once more at the next run of the program.
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Chapter 3 - The program
protection

Hardware protection key
This section should instead be carefully read if the program was bought through the Internet.

Hardware protection key - Parallel port
Plug the hardware protection key that is supplied with the program into the parallel port connector of your PC.
The hardware key should be plugged directly into the PC, before any other device, to avoid hardware conflict
with other keys.
The printer cable can then be connected to the hardware protection key, as it does not interfere with the printing
operation. If the hardware key has not been correctly installed, the program will start in demo mode.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98 and Windows Me
Windows 95, Windows 98 and Windows Me automatically recognize the hardware key, so no other operation is
required.

Windows NT, Windows 2000 and Windows XP
Windows NT, Windows 2000 and Windows XP require the installation of a software driver to enable access to
the hardware key. To install the software driver, follow this procedure:

1. start Windows, and login as Administrator

2. install the package

3. browse the program directory, and run the program SKEYADD.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP

4. restart the computer

To uninstall the software driver, follow this procedure:

1. start Windows, and login as Administrator

2. browse the program directory, and run the program SKEYRM.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP

3. restart the computer

Hardware protection key - USB port
Plug the hardware protection key, supplied with the program, into one of the USB connectors of your PC.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98, Windows Me, Windows 2000 and Windows XP
All Windows versions, except Windows NT, automatically recognize the PnP hardware key, and require the path
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to load the driver from. To install the driver, follow this procedure:

1. start Windows, and login as Administrator (if necessary)

2. install the package

3. browse the program directory, and select the folder HardKeyDrivers\ USB_9x-Me-2000-XP

Windows NT
Windows NT requires the installation of a software driver to enable the access to the hardware key. To install
the software driver, follow this procedure:

1. start Windows, and login as Administrator

2. install the package

3. browse the program directory, and run the program SKEYUSBADD.EXE in the folder
HardKeyDrivers\USB_NT4

4. restart the computer

To uninstall the software driver, follow this procedure:

1. start Windows, and login as Administrator

2. browse the program directory, and run the program SKEYUSBRM.EXE in the folder
HardKeyDrivers\USB_NT4

3. restart the computer
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Chapter 4 - Using the program in a
local network

Using the program in a local network
The programs can be used in a local network without moving the hardware key from one computer to another.
It is also possible to purchase multiple licenses to use the program on several computers at once.

The computer to which the hardware key is physically connected is defined as the “Server”, and the computer
that requests the authorisation to run in fully operational mode from to the Server is defined as the “Client”.
The program must be installed on the Server (with the proper hardware key drivers if necessary), and on each
Client (in demo mode).
The program keyserver.exe should also be installed on the Server. The installation file of this program can be
found on the distribution CD-ROM, or on the Internet, at the URL:
http://www.geoandsoft.com/download/KeyServerSetup.exe

Run keyserver.exe and the hardware key management window appears.

Click the “Create Program Configuration File” button, and browse your network to select the executable file you
want to remotely activate (for example \\computer03\c\program files\diadim32\diadim32.exe). Now, with the
keyserver.exe program running, diadim32.exe can also be run from the PC “computer03”.

NOTE: the contemporary use of the program on more then one computer is allowed only if a multiple
license has been purchased.
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Chapter 5 - General information

Usage Notations
Some typographical notations and keyboard formats are used in this manual to help locate and interpret
information more easily.

Bold print is used to indicate command names and related options. Characters appearing in bold print should
be typed exactly as printed, including spaces.

Words written in italics indicate a request for information.

CAPITAL letters are used to indicate computer, printer, directory, and file names.

Keyboard formats are used as follows:

• KEY1+KEY2 - indicates press and hold down key1 and then, at the same time, press key2. For example,
alt+c means one should press and hold the alt key down and, at the same time, press the c key. The keys
are always indicated with capital letters.

• key1,key2 - A comma (,) between key names means that the keys must be pressed in sequence. For
example, ALT,C means one should press and release the ALT key and then press and release the C key.

Because of the differences in keyboard layouts, the names of the keys on the keyboard may not correspond
with those described in this manual. The word ARROW (LEFT, UP, RIGHT, DOWN) indicates the use of the arrow
keys.
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Chapter 6 - User Interface

User Interface and Data Entering
The user interface is designed to be easy to use and powerful and is supported by complete on-line help. This
help contains practical hints and the theoretical background, where applicable. It should reduce the requirement
of  frequently consulting the printed manuals.
All the commands are located inside a menu bar. Each menu contains a list of commands that one can select
with the mouse or the keyboard. The arrangement of the menus, designed with ergonomic criteria, follows the
logical order of the operations, inhibiting the access to further operations until all the necessary data have been
entered.
The interface layout is maintained in all of our programs, to simplify, as much as possible, the transition from
one program to another to avoid having to learn different commands and procedures for similar functions (such
as entering data or managing files).
Let us examine the general components that are available in the user interface of geo&soft programs.

User Interface: Menu Bar and Menus
The Menu Bar manages the access to all the program commands. The goal of the menu design is to offer an
ergonomic, simple, and understandable arrangement of the commands.
The menus used to perform a complete operation are normally ordered left to right and top to bottom. When
possible, the following scheme is used: definition of the name of the project, entering the required data,
performing the calculation, and generating the output as a preview or final print.

The programs automatically disable some menus or commands when the execution of such menus or
commands is not yet feasible. Typical examples are: a calculation menu is disabled when not all the data
needed for the calculation have been completely entered, or a print menu is disabled if not all the calculations
have been executed.
To choose a command from a menu, use the following procedures:

Point the menu that is to be activated, click the left button of the mouse, then point the command to be
activated, and click the left button of the mouse again. If one does not wish to select any command
from the menu that is open, exit the area of the menu before releasing the mouse button.

Press the ALT key to activate the menu bar. Press, on the keyboard, the underlined character in the
menu name or press ENTER or the DOWN arrow, to select the first menu. Press on the keyboard the
underlined character in the menu name or select it using the arrow key and then press ENTER, to
execute a command in the selected menu. Press ESC to close the menus without executing any
command.

The Graphical Output Preview Window
The Toolbar is located in the upper side of the preview window.
The Toolbar allows fast access to the commands with the mouse. Click the corresponding icon, to select one of
the commands that belong to the Toolbar. The Toolbar displays the following commands:
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- Zoom + : clicking the first icon activates the ZOOM function (it can only be used with the mouse) that
permits the enlargement of part of the drawing. The function remains active until the Zoom - icon is selected.
To enlarge a part of the drawing:

click the icon, and then select the area to be enlarged by clicking the upper-left corner and dragging
the mouse pointer to the lower-right corner. At this point, release the mouse button. Note: due to the
low resolution of the screen, the texts could appear in a slightly different scale at different zoom levels.
This does not affect the quality of the final printouts.

- Zoom - : click this icon to return to the original scale of the preview.

- Arrows: click the arrow icons, in "Zoom + " mode, to pan the on-screen preview.

- Print: click the print icon to send the drawing to the default printer.

- Resized print: click this icon to send the drawing to the default printer. The image will be resized to fit the
current paper size.

- DXF: one can export the graphic output as a DXF file by clicking this icon; it gives access to a dialogue
window that enables one to assign a different name to the DXF file, which has, by default, the same name
as the current project.

- EMF/W: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Microsoft Word. Clicking this icon gives access to a dialogue window that enables
one to assign a different name to the EMF file, which has, by default, the same name as the current project.

- EMF/D: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Corel Draw. Clicking this icon gives access to a dialogue window that enables one
to assign a different name to the EMF file, which has, by default, the same name as the current project.

- Exit: click this icon to close the preview window and return to the main menu.

The Input Dialogue Windows
The different menu commands can perform an immediate action, or display a dialogue window in order to input
or edit the various data sets.
When a dialogue window is visible, all the actions that do not pertain to it are ignored. Hence, it is necessary to
close the dialogue window to resume the normal use of the program.
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Some fundamental tools are used inside the dialogue windows: data fields such as text and list boxes, and
buttons.
The text boxes are used to input numerical values and text strings. Most of the editing keys (HOME, END, INS,
DEL, etc.) can be used inside these fields. If one sees a small arrow pointing down on the right side of the data
field, one has a list box.
To scroll the list box and select an item, do as follows:

click the arrow, and then click the item to be selected.

press the DOWN arrow until one arrives at the item to be selected. It is also possible to press a letter to
directly reach the first item that begins with that letter.

Tere are three buttons in the dialogue window:

• <Ok> - this button saves the entered information and goes on to the next phase.

• <Cancel> - this button closes the Dialogue window without saving the just entered data, or without
executing the command.

• <Help> - this opens a window that contains general information on how to use the dialogue windows.

To use the buttons:

click the button

press alt+underlined letter
To edit the data inside the dialogue window, use the following keys:

• TAB - moves the cursor to the next field; when the cursor is inside the last visible field the cursor goes to the
first control button of the Dialogue window. To return to the previous field, press SHIFT+TAB.

• ENTER - moves the cursor to the next field. If the cursor is positioned on one of the window buttons, the
corresponding command is executed.

• BACKSPACE - cancels the last character that has been entered.

• DEL - cancels the character to the right of the cursor.

• ESC - closes the Dialogue window without saving the entered values or without executing the command. The
<Cancel> button will do the same.

• UP ARROW/ DOWN ARROW - these are used in multiple fields, or those fields that have a list box.

• LEFT ARROW/ RIGHT ARROW - moves the cursor to the previous or next field.

• HOME -moves the cursor to the beginning of the field.

• END - moves the cursor to the end of the field.

A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Data Input With Tables
Tables are used to enter long sequences of numerical values and/or text strings. The keys to be used are the
following:

• TAB - moves the cursor to the first button in the window. When one presses this key again, the cursor is
moved to the next button.

• SHIFT+TAB - moves the cursor to the previous button.

• ENTER - moves the cursor into the next input field. If the cursor is positioned on one of the window buttons,
the corresponding command is executed.

• PAGE UP - moves the cursor up 15 lines.

• PAGE DOWN - moves the cursor forward 15 lines.

• UP ARROW - moves the cursor to the input field directly above.

• DOWN ARROW - moves the cursor to the input field directly below.

• LEFT ARROW / right ARROW - moves the cursor to the field respectively to the left or to the right of the current
position.

• HOME - moves the cursor to the beginning of the line.
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• END - moves the cursor to the end of the line.

• F2 - copies the field contents to the extended editing field under the title bar in order to facilitate the editing
of the long strings. When working in this editing field, please REMEMBER to press ENTER, even before
clicking the <Ok> button. Double-clicking a field has the same effect as pressing the F2 key.

The tables have two additional buttons:

• <Insert> - creates an empty line before the one in which the cursor is positioned.

• <Delete> - deletes the line in which the cursor is positioned.

IMPORTANT SUGGESTION: you can copy data to or from other programs such as Microsoft Excel:

The data entered in the table can be copied in order to be pasted into another table.
To copy the table’s contents:

press the key combination CTRL+C. The contents will be copied into the Clipboard of Windows.
To paste the Clipboard contents into the table:

press the key combination SHIFT+INS, or CTRL+V.
A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Message Windows
The function of these windows is to give information to the user concerning the system status, as in the case of
an error due to an improper use of the program.

Help On Line
A complete Help On Line is available. It is possible to ask for information or suggestions related to the
commands or the use of the program. In order to access the help on line, proceed as follows:

1. Position the cursor on a field of a dialogue window and press F1.

2. Use the Summary from the Help menu.
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Chapter 7 - Commands

Files Menu (ALT,F)
This menu contains the commands for opening and saving files, that contain all the information relative to the
project. Until a name for the project has been given the program will not permit the use of other menus.

New Command (ALT,F,N)
To open a new file:

from the menu choose New by first clicking on the name of the menu then on the New command.

from the File menu choose New by using the combination of the keys ALT,F,N.

Open Command (ALT,F,O)
To be able to work with the program one should, first of all, create a new file or open a pre-existing file.To open
a file:

from the menu choose Open by first clicking on the name of the menu then on the Open command. In
the File Name field type the name of the file to be opened or, if the file already exists, double click on
the name of the desired document which can be found in the list underneath the File Name field.

from the File menu choose Open by using the combination of the keys ALT,F,O. In the File Name cell,
type the name of the file to be opened or, if the file already exists, press TAB and then the UP ARROW or
DOWN ARROW to select the name from the list underneath the File Name field and press ENTER.

The name of the file being used is shown inside the title bar of the main window and inside a window referable
by selecting the Help menu. The name of the file should not contain spaces and/or punctuation marks. It is not
necessary to indicate extensions, since the extension “.DIF” is added automatically: for example, if one enters
the name “TEST1” the file name will be “TEST1.DIF".

Save Command (ALT,F,S)
During the work session the program uses a copy of the file which is temporarily loaded into the computer’s
RAM. To save the work on the hard disk it is necessary to use the Save command; otherwise all the data
entered will be lost when one exits from the program. If an electrical problem or any other type of problem
interrupts the computer’s functioning, the data not yet saved will be lost, so it is advisable to save the work often.
To save a file:

select Save from the file menu by clicking first on the name of the menu and then on the Save
command. In the File Name field, the name given to the file when it was originally opened appears. To
confirm that name click on the <Ok> button. To assign a new name to the file, type the new name in
this field.
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select Save from the File menu by using the key combination ALT,F,S. To confirm the name given to
the file when it was opened press ENTER. To assign a new name, type the name in the File Name field
and press ENTER.

The program will save the file in the current disk unit and directory unless specified otherwise. To save the file
on a different disk unit or in a different directory, type the full path in the File Name field. For example, to save
the document in the root of disk C: type c:\filename or select a different unit or directory.

Printer Setup Command (ALT,F,P)
By selecting this command one goes to “Print” dialog box. Here one can verify and modify the Default printer’s
Setup or select another printer from those installed one ones system.



14 - DIADIM for Windows – User Guide

Edit Menu (ALT,E)
With this menu one can enter all parameters necessary to calculate the structure.

Stratigraphy Command (ALT,E,S)
With this command the values are entered pertaining to the different lithotypes traversed which are not
necessarily vertically homogeneous.

The "Geotechnical parameters of the stratigraphy" Dialog Box
The window shown contains a table where the following data are to be entered:

→ depth: distance of bottom of stratum to the surface level

→ GN: specific weight, drained;

→ GS: specific weight, saturated;

→ phi: friction angle;

→ c': drained cohesion of stratum;
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→ Ks: modulus of sub-surface under stratum. The coefficient of the sub-surface is used to model the terrain’s
behaviour. Working with the hypothesis of an ideal terrain (domain of Winkler) the sub-surface coefficient is
taken as a constant, independent of the size and the form of the surface to be loaded and its elastic
properties. When it is not known it can be calculated by the program with the method suggested by Bowles
or the one suggested by Lancelotta. To have values larger than zero at the top of the bulkhead, enter in the
stratigraphy a first stratum of zero thickness.

→ pattern code to be used in the drawing of the stratigraphy. The pattern code to fill the column that graphically
describes the stratigraphy  are made up of three numbers; the first one, optional is a scale factor comprised
between 0 and 9, the next two are the real code of the pattern. Thus it is possible to use the pattern twice
with different scales, therefore the code 907 represents pattern 7 with a not very dense hatching, while code
107 is still pattern 7 but with a quite dense hatching. To superimpose two patterns  it is sufficient to enter the
two codes one after the other (for example 912504). Moreover one can assign a colour to the pattern using
the form ”Cn” with n = number between 1 and 15 (for example 904C5 or 305712C). The number refers to
the definition of the colours contained in the printer Configuration menu. One can also add a short
description of the lithotype, this is entered after the pattern code, separated from the last with a space (for
example 902C3 Sandy loam).

When one has finished entering the data the program determines the mean values within the depth range of the
structure.



16 - DIADIM for Windows – User Guide

Textures used in drawing stratigraphies

Bulkhead Parameters Command (ALT,E,P)
Here the geotechnical and geometrical parameters of the structure are defined.

The “Bulkhead Description” Dialog Box
In the dialogue window titled “Bulkhead Description” the following data have to be entered:

→ Bulkhead top: the top of the bulkhead can be free or hinged. In case the top is free it can both move and
rotate, while in presence of a infinitely rigid restraint that offers resistance to both traction and compression,
the top of the bulkhead can only rotate

→ Bulkhead toe: The foot of the bulkhead can be free, restrained or hinged The presence of a restraint like a
hinge simulates an imperfect restrained joint with a section partially fixed into the rigid material below (a rock
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stratum), while a truly restrained joint simulates a restraint for a significant length or in a particularly rigid
material (bed-rock).

→ Downhill thrust: The horizontal limit tensions (active and passive thrusts) of the terrain can be calculated
starting from the top of the bulkhead or, more conservatively, from the surface of the excavation. An
intermediate solution can be to use an option to associate an overload (downhill) at every excavation phase
to simulate the influence on the vertical tensions of the material at the other side of the bulkhead.

→ Sub-surface modulus: The sub-surface modulus of the terrain downhill from the structure can be considered
equal to the modulus uphill or different from the last one starting from the excavation level. It is possible to
do so, as it plausible to suppose that excavation does not alter the sub-surface characteristics. The most
conservative hypothesis is however that the moduli vary with depth of the excavation plane. Here, as in the
preceding case, the application of an imaginary overload to the excavation surface contributes to reduce the
possibility of the translation of the bulkhead foot.

→ Calculation of vertical tensions: normally the calculation of bulkheads is performed in terms effective
tensions. Notwithstanding this it is possible to perform the calculation of vertical tension in terms of total
tension as well. Please note that the presence of water can be considered as a separate hydrostatic
component: to express the tensions, in terms of adding the effect of the hydrostatic thrust, can be an excess
of caution.

→ Calculation method for Ka and Kp: to evaluate the active and passive thrust coefficients one can choose
between the two, well known, methods proposed by Coulomb and Rankine.

→ Ks calculation method: the method suggested by Bowles calculates the modulus of subgrade reaction as a
function of the bearing capacity coefficients of Brinch-Hansen automatically recalculated at the different
depths, while with Lancellotta’s method ks is a function of the root of the depth and fixed coefficient 'm'
constant in the whole section. In both cases it is not necessary to enter any value in the Ks column of the
Stratigraphy command. When, however, in the stratigraphy the modulus of subgrade reaction values are
entered it is possible to select between two methods to assign this number to the whole stratum: by
selecting CONSTANT, Ks will be constant throughout the thickness of the stratum while with the LINEAR
method it will be varied linearly to the bottom of the stratum starting from the value assigned to the
preceding stratum. In order to have values larger than zero at the top of the bulkhead, enter into the
stratigraphy a stratum with zero thickness.
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→ Calculated resistance bending moment: this option, pertaining to structural verification of the section,
enables one to decide wether the calculation resistance moments, taking into account the normal force due
to the structure's own weight, have to be calculated at the extremities only and hence be linearly
interpolated or if these have to be determined at each node. The second option is more demanding in terms
of calculation time.

→ Total length of bulkhead: depth of the foot measured the top.

→ Stiffness of the bulkhead (EJ): please note that this value derived from the geometry of the section and
eventual reinforcement bars or covering should be referred to a unit length of the structure therefore
diaphragms and bulkheads made from distinct elements will have an EJ value equal to each single element
divided by the axis to axis distance between two successive elements. In case the geometry of the bulkhead
has been defined the program will recalculate the value of EJ and ask confirmation to substitute this value.

→ ‘m’ Coefficient: coefficient to determine sub-surface modulus ks according to Lancellotta’s method.

→ Constant horizontal thrust: it is possible to add an additional horizontal thrust force with depth, positive
downhill, to verify the maximum excursion of the beam’s elastic line, on deformable supports.

→ Overload uphill: the overload applied uphill from the bulkhead is added to the vertical tension, effective or
total, calculated from the lithostratigraphic succession of the terrain.

→ External moment: It is possible to consider the effect of an external moment applied to the top of the
bulkhead due, for example, to vertical loads applied to a corbel.

→ External force: It is possible to consider the effect of a horizontal force applied to the top of the bulkhead

→ Normal load: It is possible to consider in the structural calculation the effect of a normal load applied to the
top of the bulkhead. Please note that this value should be entered per linear metre of the bulkhead. To
calculate single piles it is therefore sufficient to enter a unit value of the centre to centre distance of the piles.

→ Dip of surface plane: The inclination, positive when the terrain rises away from the bulkhead, has an
influence on the calculation of the passive and active thrust coefficients.

→ Depth of water table uphill: The depth of the water-table is used by the program to define the contact plane
between not saturated and saturated soil. Water exerts a hydrostatic pressure on the bulkhead, hence the
presence of a water-table uphill makes the load conditions much more severe. It is a good idea to take into
consideration the effect of water, especially when because of low permeability of the soil,  one is not sure to
guarantee a perfect drainage of the soil uphill from the bulkhead. When one enters a depth value of 999 (or
in any case larger that the length of the bulkhead) the water-table has no effect on the bulkhead.

→ Convergence speed: under some situations, for example when dealing with cohesive soils with overloads,
the variations between successive iterations can be so large as to render impossible the solution of the
model, that tends to converge under a unstable oscillating condition. In this case it is necessary to enter a
convergence speed less than 100; in this way, as only one level of the calculated deformation has been
defined in the current iteration, the model can be  resolved with success.

When one has finished entering the data click on the <OK> button to close the window.

Structure Description Command (ALT,E,D)
Enables one to structurally verify a continuous bulkhead or one made from a row of reinforced or non-reinforced
piles or even metal sheet-piling using the limit state method.

The "EJ calculation and structure verification" Dialog Box
When one selects “Continual Diaphragm” the diameters of the reinforcements should be entered and the
distance between their axes, the thickness of the covering, the thickness of the bulkhead, the elastic limit and
the resistance limit of the steel and cement.
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Selecting “Pile wall” the external and internal diameter, the axis to axis distance between them and the
mechanical properties of the materials should be entered.

          

Selecting “Sheet piling” the thickness and length of the back, the thickness, the width and height of the ribs and
the mechanical properties of steel should be entered.
Selecting “Reinforced pile wall“ the external diameter, the axis to axis distance between the piles, the distance
between the brackets and their diameter, the thickness of the cement covering and the mechanical properties of
the materials should be entered.

Once these values are known the program calculates the stiffness of the structure and performs the structural
calculation, verifying the safety conditions required by the norm.

Safety Factor Command (ALT,E,F)
This command allows  to define thetwo different safety factors used in the stuctural analysis (Eurocode 2).

The “Safety Factor” Dialog Box
In the window called “Safety Factor” one should enter:
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→ Partial safety factor coefficient of concrete: factor to divide the resistance to cylindrical compression
characteristic of concrete so as to obtain the value for the calculation resistance.

→ Partial safety factor coefficient of steel: factor to divide the characteristic yield stress of steel so as to obtain
the value for the calculation resistance.

→ Partial safety factor coefficient on forces: multiplication factor for the forces necessary to verify the limit state
of said value.

Stay Bolt Parameters Command (ALT,E,B)
Here one can define the parameters of the stay bolts for anchoring or props.

The “Parameters of Stay Bolt” Dialog Box
In the window called “Parameters of Stay Bolt” one should enter:

→ Depth: distance from the top of the bulkhead to the stay bolt.

→ Rigidity: deformability modulus of the stay bolt.

→ Pre-load: pre-load applied to the stay bolt.

→ Type: by entering 0, one models a stay bolt resisting only to traction, yielding a reaction when negative
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deformations take place only to the point of absorbing the eventual pre-load. By entering 1, an element is
modelled capable of inverting the direction of the reaction when large negative deformations of the bulkhead
take place in uphill direction.

Excavation Phases Command (ALT,E,E)
This command permits one to define the various phases of the excavation. It is important to follow correctly the
excavation phases and installation of stay bolts as the behaviour of the bulkhead could vary a lot (negatively on
the safety factor) when one does not take into account the deformations formed previously and one effects not
only one excavation phase.

The “Excavation phases” Dialog Box
In the “Excavation phases” window one should enter:

→ Depth: depth reached by the excavation in a determined excavation phase.

→ Number of stay bolts: total number of stay bolts applied at the depth reached by the excavation. In order to
calculate correctly the tension in the stay bolts taking into account deformations induced from previous
excavation phases. It must be noted that a rigorous approach to the analysis of each phase of earth removal
should be done in two steps as the stay bolts are mounted after the stripping and thus after the deformation
of the bulkhead. This is especially true when the stripping level is substantially lowered after each earth
removal phase.

→ Overload: the overload applied downhill from the bulkhead is added to the vertical tension, effective or total,
calculated on the base of the lithostratigraphic succession of the terrain. This option, pertaining to the
association of an overload (downhill) to each stripping phase, makes it possible to simulate the influence on
the vertical tensions of the material on the other side of the bulkhead.

→ Depth of water table downhill: this ought to be defined from top of the structure and not from the excavation
level. Water exerts a hydrostatic pressure on the bulkhead which downhill improves the load conditions. It is
advisable not to take into account the water effect especially when because of high permeability of materials
downhill one has doubts on the possible natural drainage downhill from the structure. When one enters a
depth equal to 999 (or larger that the length of the bulkhead) the water table has no effect on the bulkhead.

Titles Command (ALT,E,T)
In order to facilitate the reading of the drawings one can enter some titles; these are drawn in the drawing’s
header.
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Print Menu (ALT,P)
With this menu it is possible to produce graphic output or listings of all data by selecting from the following menu
titles: Graphics and Listings.

Graphics Command (ALT,P,G)
With this command one has access to a sub-menu, used to select the result to be visualised and printed.

Moments Command (ALT,P,G,M)
If the calculations have not yet been performed the program will perform these now and after this draw the
diagram of the moments with, separately, the various excavation phases.

Displacements Command (ALT,P,G,D)
If the calculations have not yet been performed the program will perform these now and after this draw the
diagram of the movements with, separately, the various excavation phases.

Shear Command (ALT,P,G,S)
If the calculations have not yet been performed the program will perform these now and after this draw the shear
diagram with, separately, the various excavation phases.

Pressures Command (ALT,P,G,P)
If the calculations have not yet been performed the program will perform these now and after this draw the
pressure diagram with, separately, the various excavation phases.

Structural Elements Command (ALT,P,G,E)
If the calculations have not yet been performed the program will perform these now and after this draw the
structural element used with, separately, the various excavation phases.

Stratigraphic Description Command (ALT,P,G,T)
With this command one can draw the stratigraphical-geotechnical description. In the drawing the depth of the
strata is shown, the description and lithotype description, the water table depth and the drawings of the
geotechnical parameters (friction angle, specific weight drained and saturated, drained cohesion).

Listings Command (ALT,P,L)
By selecting this command the program opens a sub-menu where one can select the preview mode, and wether
to print or export the listing.

Listing Preview Command (ALT,P,L,P)
With this command it is possible to preview the listings pertaining to the calculation result. The listing can not be
changed here.
To scroll the text use the scroll bars on the window or use the UP and DOWN arrow keys, or the PAGE UP e PAGE
DOWN. keys. To exit press ESC or double-click any point of the listing.
The file containing the listing is saved on disc in the same directory where the data files resides. It has the same
name with the difference of the ".TAB" extension. The file is in the normal ASCII format and its pagination is



24 - DIADIM for Windows – User Guide

such that all commands have the # sign as prefix.

Listing Direct Print Command (ALT,P,L,D)
With this command the listings pertaining to the calculation result are printed directly.

Listing Export to DOC (ALT,P,L,E)
With this command the listings pertaining to the calculation result are exported in the format used by Microsoft
Word 97.
The file will have the same name but with the ".DOC" extension and will be saved in the same directory where
the data files reside.

Listing Export to TXT (ALT,P,L,T)
With this command the listings pertaining to the calculation result are exported in the “Text only” format.
The file will have the same name but with the ".TXT extension and will be saved in the same directory where the
data files reside.

Listing Export to SLK (ALT,P,L,S)
With this command, it is possible to export the listings of the calculation results into the SLK format (Microsoft
Excel 97 compatible).
The program creates a file, with the same name as the current project but with the ".SLK" extension; the file is
saved in the same directory as the data files.
The file is automatically opened if the program finds the Microsoft Excel executable.

Full Listing Export to SLK (ALT,P,L,F)
With this command, it is possible to export the complete listing of the calculation results into the SLK format
(Microsoft Excel 97 compatible).
The program creates a file, with the same name as the current project but with the ".SLK" extension; the file is
saved in the same directory as the data files.
The file is automatically opened if the program finds the Microsoft Excel executable.

Configure Command (ALT,P,C)
With this command, one can define the graphical properties of the different objects in the graphical output.

One can associate a colour, a line thickness and a character font to each object. Notice that not all the objects
have both a line thickness and a character font: for example, a title only requires the colour and the character
font to be defined.

• Click an object to select it (use the scroll bar to see the entire list)

• Click one of the option buttons, in the “colours” frame, to select the colour that has to be associated to the
selected object. The Not drawn option hides the object of the graphical output.

• If the object contains texts, one can choose a character font from the list (use the scroll bar to see the entire
list)
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• If the object contains lines, one can assign a thickness to the lines (in mm). If the value is zero, the program
uses the thinnest line on the output device.

• It is possible, as an option,  to assign a left and a top margin (in cm) to the whole graphical output.

NOTE: although the available set is limited to fifteen colours, they can be manually customised; double-click the
coloured bar to open the Colour Dialogue Box and choose a different RGB value associated to the selected
colour.
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Exit Menu (ALT,X)
This command allows one to exit the program.
If the file being used contains modifications that have not yet been saved the program will propose the file
saving window, if you would like to save these modifications.
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